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These notes are intended as a ‘Quick Start’ guide to Adobe Premiere Pro CS6. Premiere Pro CS5 is similar but lacks 
a few features. The shortcuts and screenshots are based on the Apple Mac version – the Windows version is similar 
but the keyboard shortcuts will predominantly use the Control key rather than the Mac’s Command key.

If you plan to edit footage from a video camera, consider copying the camera card(s) to a hard disk before starting 
to edit. Always back up important footage. Always copy ALL the files and folders from a camera to a new folder, 
named sensibly.

Some terminology
A Premiere Pro Project contains all the information (metadata) about your edit. It contains links to all your Media 
(camera files, audio, graphics and so on) that you use. These links appear as Clips in the Project Panel in Premiere 
Pro. You import or drag media into your project to create the clips. You then load clips in turn into the Source 
Monitor, mark sections you wish to use and add them to a Sequence, which is viewed in the Program Monitor. A 
sequence is a type of clip, so it is created and stored in the Project Panel. Your sequences also appear in Premiere 
Pro’s Timeline, which shows clips and other items such as titles, in a graphical display. Many editing operations are 
carried out in the Timeline.

Opening Premiere Pro
Launch Premiere Pro (either from the Applications folder or the Dock). 
You’ll be presented with a splash screen where you may create a new project 
or open an existing project (recent projects are listed).

If you need to reset the Premiere Pro preferences for any reason, hold 
Shift+Option as you launch the application.

Starting a new Project
Since most choices about formats, frame rates and so on are set in sequences, creating a project is straightforward. 
Click ‘New Project’ and a dialogue box opens (below).

In the General tab (left), choose a location for the pro-
ject and name it. There are video and audio TC display 
options and one for tape capture. This only offers DV 
and HDV unless the computer has a video card such a 
Blackmagic or AJA card.

The Scratch Disks tab (right) offers choices for any 
captured video and audio and the preview files created 
during editing. The default location is within the user’s 
Documents folder which may not be ideal. Consider 
making a folder on a large removable drive for all video 
and audio.

An Introduction to Adobe Premiere Pro
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The project and video locations need not be in the same place but make sure you know exactly where you saved the pro-
ject as you may need to copy it or back it up.

Click ‘OK’. If you get an error message about the location of the Scratch folder, quit, relaunch and reset the prefer-
ences (see previous page). Once the project is created, you’ll then see a dialogue box for creating the first sequence. 
Many SD and HD presets are available. Choose one that is closest to the majority of the footage that you plan to 
edit. It is also possible to automatically create a sequence that matches a source clip (see later).

If you can’t find a preset that exactly matches your needs, choose one that is close, then click the Settings tab to 
fine-tune your selection if you wish (it does help to know exactly what your camera files are!).
Once you’ve made adjustments here, you can save a preset for use in future. Finally, you can set the number of 
tracks in the new sequence; the default is three video tracks and three stereo audio tracks. More tracks can be 
added later. Click ‘OK’ when done and the project will open.

Premiere Pro will create cached 
files to aid playback while editing. 
The default location of these files is 
Users/<user>/Library/Application 
Support/Adobe/Common. You’ll 
need to clear these files out occasion-
ally so it’s possible to change the 
location to one that’s easier to access 
and remember (perhaps alongside 
the video and audio locations you set 
earlier).

To change the cache location, go to Preferences>Media and browse to a new folder. You can leave the Cache
Database in the default location. Click ‘OK’ when done.

User Interface layout
The main panels seen in the default UI (see over page) are the Source and Program monitors, the Timeline and the 
Project Panel. The Project Panel contains sequences and any clips that are imported; new bins or folders can be cre-
ated in the Project Panel to help organise material. You can change the layout using preset Workspaces (look in the 
Window menu). If you change one of Adobe’s presets, the change happens instantly but you can reset the Work-
space to its default. You can create and modify your own Workspaces, to show the Media Browser, for instance.

Rather than changing a default Workspace, make a new one (Window>Workspace>New Workspace) as soon as you’ve 
made adjustments as ‘Reset Current Workspace’ will return the display to the default.

New Sequence: Preset Tab                                                            Sequence Settings Tab
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Browsing for Media
Premiere Pro does not have a native format or codec and it will cope with most common formats including Quick-
Time, AVCHD, P2, XDCAM and so on. To search for media, make the Media Browser visible; it is in a tab hidden 
behind the Project Panel when using the default workspace.

Any disks or network drives will be shown in the left-hand side of the browser. Navigate to the disk or folder con-
taining the media files you wish to edit – they’ll show up in the right-hand panel.
You can either:

 1)  double-click a clip icon in the browser to load it into the Source Monitor or:
 2) drag clips from the browser to the Project Panel or:

Drag clips from the Browser to the Project Panel

                                Source Monitor                                                                  Program Monitor

Project Panel                                      Toolbox                             Timeline                                                                                   Audio Meter     

The User Interface
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 2) Right-click and choose ‘Import’ – they’ll appear in the Project Panel.

The Project Panel
Master Clips and sequences are displayed in the Project Panel. Different sorts of clips have different icons:

A bin (the term comes from the 
trims bins found in a film cutting 
room) appears as a folder and can 
either be created by the user (right-
click>New Bin) or automatically 
if you browse to a camera card or 
card copy rather than individual 
files. The bin will contain the clips 
found on the card.

Creating a new sequence
If you need to create a new sequence, go to 
File>New>Sequence – you’ll get the same choices 
discussed earlier.

To quickly create a sequence with the same format of one of your 
master clips (frame rate, frame size and aspect ratio), select the clip 
in the bin then choose File>New>Sequence From Clip. Alterna-
tively, drag a clip to the New Item icon at the bottom right of the 
Project Panel. In these cases, the sequence is created with the same 
name as the Master Clip (rename it) and the clip is included in the 
sequence.

Starting to edit
1) Drag from Project Panel
The most basic way to assemble material is to simply drag clips from the Project Panel into the Timeline. The clips 
you drag will snap to the head (start) or tail (end) of other clips in the clips in the sequence. If you release the 
mouse within an existing clip, the new clip will overwrite it, replacing material in the sequence. To insert the new 
clip within a sequence, hold the command key as you drag.

2) View in Source Monitor before editing
A more controlled routine is to load a clip into the Source Monitor. This way, you can mark the section and tracks 
you need before editing. Double-click a clip in the Project Panel or Browser and it will load into the monitor.
Play the clip by pressing the spacebar on the keyboard; press again to stop (or use the play button under the moni-
tor). To play back and forwards, use the J, K and L keys on the keyboard. L plays forwards, K pauses play and J 
plays in reverse. Pressing J or L a second, third or fourth time in succession increases the play rate. To play slowly 
through a clip, hold down K (pause) together with J or L.

To move one frame at a time, use the Step Back or Step Forward buttons under the monitor or the left and right cur-
sor keys on the keyboard.

To scrub (monitor) audio while moving frame by frame, turn 
on ‘Play audio while scrubbing’ (Preferences>Audio). This 
makes it easy to find audio cues.

Clips in the Project Panel

Master Clip (audio only)
Master Clip (video and audio)
Master Clip (video only)
Master Clip (still graphic)
Sequence
Bin (folder) containing clips

Drag clip to ‘New Item’ to create sequence

Click to activate scrubbing
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To mark a section of the clip, use Mark In and mark Out under the monitor, or ‘I’ (Mark In) and ‘O’ (Mark Out) on 
the keyboard.

Option+I clears the In point, Option+O clears the Out point and Option+X clears both marks.

You can now drag from the Source Monitor to the Timeline. To take just video or just audio, 
drag using the frame or waveform icon under the monitor.

Alternatively, use the Insert or Overwrite buttons under the monitor. On the keyboard, Insert is the comma key (‘,’) 
and the Overwrite key is the full stop key (‘.’). The Insert and Overwrite commands offer much greater flexibility 
when placing clips in the Timeline.

When you add clips using the Insert or Overwrite commands, they are placed at the position of the Playhead, un-
less an In or Out mark has been set in the Timeline – see the later section on three-point Editing.

The Track Panel
When you load a clip into the source monitor, or there is a sequence in the Timeline, 
a small panel with buttons appears at the left hand end of the Timeline (see right). 
This is the Track Panel and it determines which tracks get edited.

To turn tracks on and off, click on the track selectors. Source side selectors are la-
belled V, A1 etc; program side selectors are labelled Video 1, Audio 1 etc. To over-
write just the video (say) make sure that the video track selectors are turned on on 
both source and program sides and all audio tracks are off on the program side, and 
make the edit. Active tracks have light grey buttons. Inactive tracks are dark grey.

Learning to use the track panel correctly is vital when using the Insert and Over-
write commands.

Video only   Audio only

Source side            Program side
Track Selectors     Track Selectors

Mark In   Mark Out   Go to In   Step Back   Play/Stop   Step Forward   Go to Out   Insert   Overwrite

Clip duration
Playhead

Marked duration
Marked section

Track Panel       Playhead       Work Area

Source tracks       Program tracks Timeline after first edit
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Patching tracks
When clips are edited, they are sent to the adjacent record side track. To edit to a differ-
ent track, click on the source side track selector and drag it up or down until it is next to 
the destination track selector.

To avoid mistakes, check the track selectors on the record side. Only those selected 
(light grey) will be edited. If you have an audio only clip in the source monitor (say) 
and you have all the track selectors selected on the record side, a segment of filler 
(black) will be added to the video track to match the duration of the added audio.

Adding clips within a sequence
When adding clips part way through a sequence, you need to decide whether to Insert (which will push [ripple] 
the following clips down the Timeline) or Overwrite (which will replace part of your sequence with new footage). 
Here’s how they work, with a short sequence containing three clips, named Cat, Mouse and Fish:

Insert:
A fourth clip, ‘Dog’, 5 seconds long, will be inserted in to the sequence between the first and second clips.

After the edit, ‘Mouse’ and ‘Fish’ are rippled down the sequence by the new clip and the sequence lengthens. The 
playhead moves to the end of the new clip.

Overwrite:
‘Dog’ will be overwritten at the playhead, which is between the first and second clips.

After the edit, ‘Dog’ completely overwrites ‘Mouse’ and the first part of ‘Fish’ but the sequence stays the same 
length as it was before the edit. The playhead moves to the end of the new clip.

Three-point editing
A very accurate way to overwrite is to use the three-point editing technique. This involves any combination of 
three marks – say an In and Out in the Source Monitor and an In in the Timeline (as in the previous example where 
the Playhead acts as an In point). Alternatively, set an Out point in the Timeline – the Out point set in the Source 
Monitor will synchronise with this Out point.

You can also set an In and an Out in the Timeline – in this case, set either an In or an Out (not both!) in the Source 
Monitor. When you overwrite, the matching marks will synchronise. This is a useful technique when placing pic-
tures to an audio track such as music or commentary.

If you set four marks, there is a conflict and an alert message opens (see over page) – choose one of the options to 
resolve the conflict.

Cat (6 secs) Mouse (4) Fish (8 secs)

Dog (5 secs)

Sequence before inserting fourth clip

Dog (5 secs)Cat (6 secs) Mouse (4) Fish (8 secs)

Fourth clip inserted (sequence lengthens)

Cat (6 secs)

Cat (6 secs)

Mouse (4)

Mouse (4)

Fish (8 secs)

Fish (7 secs)

Dog (5 secs)

Dog (5 secs)

Sequence before overwriting in fourth clip

Sequence after overwriting in fourth clip

Drag to patch tracks
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Adding clips that don’t match the sequence
If you wish to add clips that don’t match the sequence frame size, check 
Premiere Pro Preferences>General. A setting here determines whether non-
matching clips are resized when edited or left as they are. It’s important to 
understand that the setting applies to the clips at the point they are added to the Project Panel. Changing the setting has 
no effect on clips that are already in the project.

Moving along the sequence
Clips can be added anywhere but it’s useful to move exactly to an existing cut. The up and down cursor keys on 
the keyboard will move you the next cut in the sequence, depending on how the program side track selectors are 
set. For instance, if Video 1 and Audio 1 are turned on, and you press the down arrow, then the playhead will move 
to the next cut or transition where both the selected tracks cut on the same frame. In a complicated sequence, with 
many tracks and split edits, you may find the playhead shoots straight to the start or end of the sequence, these be-
ing the only points where all the tracks cut together.

The track selection dependence can be temporarily turned off by holding down the Shift key while using the cursor 
keys (the playhead will move to every cut). Note that the playhead parks on the first (head) frame of the incoming 
clip.

If you drag the playhead along the timeline (drag on the TC ruler) you can snap to 
cuts by holding down Shift.

Shift+I takes you to an In mark and Shift+O takes you to an Out mark.

To zoom in and out on the Timeline use ‘   ’ and ‘  ’. To fit the complete sequence into the Timeline window, use ‘   ’.

Removing material
There are several ways to remove material from a sequence. First select which clips or parts of clips to delete.

Removing entire clips
To remove one or more complete clips, choose the Selector icon in the Tool Palette or press V on the keyboard.

With the Selector, select one or more clips in the Timeline (cuts or transitions between clips can also be selected but 
that will be covered later).

To select a clip in the Timeline, simply click it while the Selector is active (see below). Click and drag or click and 
shift-click to select multiple clips.

Pressing the Backspace or Delete (Clear) key will lift out the material, leaving filler (empty space) in the sequence:

Selected clip

+ - \

‘Fit Clip’ alert
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Pressing Shift+Forward Delete key will carry out what is called a ‘Ripple Delete’ – the clip is extracted and the 
following clips move or ripple or move up. The sequence is shortened – there is no gap.

Removing material with Lift and Extract
To remove any sections from the sequence that are not defined by complete clips, set In and Out marks in the 
Timeline to define the area to remove. In the Track Panel, select the tracks that will be modified and deselect any 
others.

Lift (under the Program monitor or ‘  ’ (semicolon on the keyboard) lifts out the marked section, leaving 
black video or silent audio in its place.

Any tracks that were not selected are ignored by the edit.

Extract (under the Program monitor or ‘  ’ (the quote key on the keyboard) extracts the marked section, 
shortening the sequence.

To avoid putting downstream clips out of sync, when extracting or inserting material, the 
Track Panel sync locks are on by default – they remove material from all sync-locked tracks, 
even if the tracks are not selected.

Using Extract (also called a Ripple Delete) with the sync locks on in this case 
gives the following result: 

Material has been extracted from ‘Bambeleo’ on Audio 2, even though it was not selected, as the sync locks were 
on. Doing the extract with the sync lock off on Audio 2 gives the following result:

This time, Audio 2 has been ignored and material has only been extracted on Video 1 and Audio 1. 

Material lifted from Video 1 and Audio 1

‘

Sync Locks

Material extracted from Video 1 and Audio 1 and Audio 2

;

In mark                            Out mark

Active tracks (Video 1 and Audio 1)
Marked section in Timeline
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Moving clips along the Timeline

Clips may be moved to a different position in the se-
quence simply by dragging. One or more clips may be 
selected – to select a clip, simply click it with the selector 
tool (V) and drag. There are three methods:

1) Lift+Overwrite
The default behaviour is to lift clips from their original position and overwrite them at the point where the mouse 
is released. The starting location is filled with black video and silent audio.

2) Lift+Insert
Start to drag the clip(s). When you reach the destination, hold down the Command key. The clip will be inserted 
into the sequence, pushing subsequent clips to the right (rippling them along the Timeline). The starting location is 
filled with black video and silent audio. The sequence lengthens by the duration of the clips that were moved.

2) Extract+Insert
Start to drag the clip(s). When you reach the destination, hold down the Command and Option keys. The clip will 
be inserted into the sequence, pushing subsequent clips to the right (rippling them along the Timeline). The starting 
location is closed up (an extract). The sequence duration remains as it was.

To nudge selected segments left or right by one frame, use the left or right cursor key in conjunction with the Com-
mand key. Holding shift trims by plus or minus 5 frames.

Snapping
When moving items along the Timeline, you can snap to the cuts as you go. Turn snapping 
on and off with the S key on the keyboard or from the icon in the Timeline.

Clip Linking
If a clip has been captured with both video and audio, they’ll be normally linked together, so that dragging the 
video segment moves the associated audio, too. You can unlink a clip; select it, then Clip Menu>Unlink. This allows 
video or audio to be adjusted independently. To temporarily unlink a segment, Option+click it as you select it.

If Snapping is turned on, the heads and tails of moving clips automatically snap to existing cuts, the Playhead or 
an In or Out mark – setting the Playhead is a good way of ensuring that the clip or clips end up in the right place, if 
the destination doesn’t coincide with an existing cut. When moving a segment vertically, the clip will not slip left or 
right as it will stay aligned with its original position unless the mouse is dragged off to one side by a considerable 
amount. If moving clips vertically, new destination tracks are created as required.

• When you click on a clip or transition in the Timeline, it will usually be selected (depending on the ac-
tive tool). To move the Playhead to a new position without selecting anything, click or drag in the timecode ruler 
at the top of the Timeline window. To deselect items, click outside the track area or use the keyboard shortcut 
Shift+Cmnd+A.

Toggle Snapping

CatMouseFish Fish

‘Dog’ moved left, inserts into ‘Fish’, ripples other clips to right, gap remains

Dog

Fish CatMouseFish

‘Dog’ moved left, inserts into ‘Fish’, ripples other clips to right, gap is closed

Dog

Dragging a clip along the Timeline

CatMouseFish

Before moving ‘Dog’ 

Dog

CatMouseFish Fish

‘Dog’ moved left, overwrites ‘Fish’

Dog
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Basic Trimming
Trimming a clip changes its duration in the Timeline. It is easy to shorten a clip (a gap will be left in the 
sequence) using the standard Selection tool but to lengthen a clip you need one of the Trim tools.

Trimming frames away
To shorten a clip duration by dragging in the timeline, 
make sure the Selection tool is active (press ‘V’ on the 
keyboard) then click and drag either the head or tail 
of a clip. The cursor changes to a red arrow as you 
trim:

After the adjustment, black video and silent audio 
replaces the frames that have been trimmed away:

You cannot lengthen a clip with the selection tool un-
less there is an adjacent gap in the sequence.

Ripple trims
To shorten or lengthen or shorten a clip in the sequence without leaving a gap, and with the freedom to extend a 
clip to the extent that was originally captured, use a Ripple edit. Choose the Ripple tool from the Tool Palette (see 
top right on this page). With the Ripple Edit tool active, move to a transition in the Timeline and move the mouse 
to the outgoing or incoming side before clicking and dragging to perform the edit. The cursor becomes a yellow 
arrow when performing a ripple edit.

When you carry out a Ripple edit, the clip you are adjusting is changed in duration and the adjacent clip in the 
sequence is pushed down or pulled up, depending on how the edit is carried out.

In this example, the head of ‘Ducks by pub’ is being trimmed to the right, on Video 1 and Audio 1 only:

When the mouse is released, the clip is shortened at the head and downstream clips are moved left:

In this example, the head of ‘Guide Mottos’ is being trimmed to the left, thus lengthened, on Video 1 and Audio 1 
only:

When the mouse is released, the clip is lengthened at the head and downstream clips are moved right:

A floating tooltip indicates the number of seconds and frames you’ve trimmed.

Selection Tool

Ripple Edit Tool

Rolling Edit Tool

Trimming away an incoming clip
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Rolling Trims
A Rolling trim will adjust both sides of the cut simultaneously – extending the outgoing and shortening the incom-
ing or shortening the incoming and extending the outgoing. Choose the Rolling Edit tool from the Tool palette (see 
the top of previous page) and click the transition you need to adjust in the Timeline. Rolling trims are frequently 
used to create a split edit, by (usually) moving the video cut away from the audio cut. If the video and audio are 
linked, hold down the Option key and click on a cut in the Timeline with the Rolling Edit tool:

When done, the sequence duration is unchanged.

Other trimming methods
Trim using the keyboard
On the keyboard, the following keys adjust the current trim selection(s):
Option+right cursor key   Trim 1 frame right
Option+left cursor key   Trim 1 frame left
Shift+Option+right cursor key  Trim 5 frames right *
Shift+Option+left cursor key  Trim 5 frames left *

* This value can be changed in the Trim Preferences.

Dynamic trimming with JKL
Double-clicking a cut with the Selection tool 
or one of the two trimming tools opens a trim 
window in the Program monitor, showing the 
outgoing and incoming frames at the cut.

The window contains trim buttons (1 and 5 
frames left or right) and trim offset indicators 
showing how many frames have been added 
or removed.

By clicking on the lefthand or righthand 
frame, you can set which side to trim (trim 
icons are visible, see below right).

Once the trim is set up, either use the but-
tons or the keyboard equivalents to trim. To 
get feedback on how far you are trimming, 
especially with audio, use the J-K-L keys on 
the keyboard.

J will play and trim the cut to the left.

L will play and trim the cut to the right.

K will pause.

To review the trim, while the trim monitor is still open, press the Spacebar. The system will back up a couple of 
seconds and then loop play the edit **. You can use the keyboard trimming commands while in loop play to make 
fine adjustments – you’ll see the changes on the next loop around.

** The Preroll and Postroll can be adjusted in the Playback Preferences.

Drag the selected cut with the Rolling Edit tool to create a split edit

Offset indicator                 Trim buttons

Last frame of outgoing clip                 First frame of incoming clip

Click to trim outgoing side

Click to trim incoming side
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Working with audio
It’s important to get audio levels right and to interpret mono and stereo clips correctly. It’s also important to bal-
ance various audio elements in a sequence and to be able to fade audio clips up and down as needed.

Checking clips in the Project Panel
You can modify audio levels and set clips to be treated as mono or stereo after selecting them in the Project Panel 
(they can also be modified in the Timeline). When clips with audio are imported, Premiere Pro attempts to interpret 
the tracks in the clip. Sometimes a multi-track clip might be stereo (such as a music track) or dual-mono (perhaps 
where an interview has been recorded with a mono microphone on one channel of a camera, leaving the other 
channel to pick up background noise). A quick way to get an idea of what is on the tracks is to view the audio 
waveforms in the source monitor.

To do this, click the small spanner icon at the righthand 
side of the source monitor and choose Audio Waveforms 
from the menu (the default is Composite Video). Alter-
natively, right-click in the monitor and go to the Display 
Mode sub-menu. Some examples are shown below.

The dual-mono example is typical of a camera recording with only one channel. Sometimes a waveform will be 
displayed on both channels – in this case check each channel in turn – you can do this using the audio meter.

The Audio Meter
The Audio Meter shows playback levels of the clip in the source monitor or the sequence in the 
timeline and program monitor, depending on which window is active. The number of channels 
monitored in the source monitor will typically be 2, 4 or 8, depending on the clip. In the timeline, 
there will usually only be two channels as the sequence is mixed down to two channels for output.

You can solo a channel by clicking the ‘S’ in the mixer, allowing just one channel to play – useful for 
checking which one to use.

Clips can be switched from mono to stereo in the Project Panel.

Select the clip(s) , right-click and choose Modify>Audio 
Channels. The Modify Clip dialogue opens:

The default setting is ‘Use File’. Choose an 
appropriate alternative. A stereo clip shows up 
as one track in the Timeline. Mono clips dis-
play multiple tracks, making it easy to choose 
the best source track for the edit.

Click to see display options

Stereo clip (L-R)                                          Dual-mono (silent on Ch 1)                8 Channel mono (XDCAM HD)

Solo

Stereo clip in Track Panel                                             Dual-mono clip in Track Panel
Audio
Meter
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Audio levels
The audio meter reads digital audio levels. The maximum level that can be reached is referred 
to as zero (0dB) and lower levels have negative values (-10dB, -18db and so on).  For broadcast, 
-10dB is the maximum permitted, leaving 10dB of headroom. For non-broadcast, levels can be a 
little higher but do leave 4-5dB of headroom. If the levels hit zero, you’ll get unpleasant distor-
tion.

Many audio clips are at too high a level for video use without adjustment – tracks from au-
dio CDs, for example, are likely to hit nearly 0dB on the meter. It’s possible to adjust clip lev-
els before adding them to a sequence. Select the clip(s) in the Project Panel and choose Audio 
Options>Audio Gain from the Clip menu.

For CD tracks, you can typically adjust them to -10dB (this 
is not an absolute level, it relates to the level of the original 
clip). This will give plenty of flexibility for adjustment later.

Low level clips (perhaps a quiet interviewee) can be increased in 
level if required.

Adjusting clip levels in the Timeline
Clip levels (and pan) can be modified in the Timeline. Each audio track can be expanded (click the disclosure trian-
gle) to reveal a volume level graph and the audio waveform. The track height can be increased by dragging on the 
bottom edge of a track in the track panel.

Varying clip level with keyframes
To adjust the level within a clip (to dip music behind speech for example), use keyframes. The idea is simple; if the 
level at one keyframe is higher or lower than the next keyframe, the audio level decreases or increases. To add a 
keyframe to the volume display, choose the Pen tool from the tool palette, then click on the volume display.

Click and drag a keyframe up and down to change the level (you can do this with the Se-
lection tool after the keyframes are in place). A tooltip overlay appears as you adjust levels.

Click to
expand
track

Click and drag to adjust clip level

Click and drag
to change 
track height

Keyframes                  Pen Tool

Overlay shows levels
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Click and shift+click to select multiple keyframes. Single or multiple keyframes can be moved up and down or 
left and right. Clicking and dragging on the volume level line between two keyframes will adjust the level of them 
both.

The default Timeline setting is that volume levels and keyframes modify individual 
clips. To make global changes to an entire track, click on the keyframe icon in the track 
panel to change the settings.

To show or hide the audio waveform, click the display icon.

If the Track Keyframes or Track Volume options 
are active, keyframes and levels apply to an entire 
track and can run across multiple clips. Likewise, 
the level of an entire track can be adjusted by drag-
ging the volume level without any keyframes.

To take this one step further, it is possible to adjust the master output of an entire sequence.

Selected keyframes can be deleted with the Backspace or Delete keys on the keyboard.

Display icon
Keyframe icon

Track Panel audio options

Making a track-based adjustment

Adjusting the Master output

Click to open
Master controls
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Basic adjustments to video clips
Simple adjustments to video clips can be made without adding any video effects. When a clip is selected in the 
Timeline, basic controls can be found in the Effect Control panel. This may be a tab hidden behind the Source Moni-
tor.

The Motion pane has controls for position, height, width (size) and rotation. The Opacity pane is useful when 
superimposing one clip over another. This is done by editing one clip on to a higher track than Video 1 (patch the 
tracks in the same way as audio tracks).

Video monitoring is done from the top down, so the clip on Video 2 is superimposed on the background clip on 
Video 1. By resizing with the effect controls, a Picture-In-Picture results.

If you click on the word ‘Motion’ in the Effect Control panel, a wireframe with adjustment handles appears on the 
selected clip – click and drag in the Program monitor to resize or reposition.

To adjust a value in one of the effect control panes, 
either click and type in a new value or click and drag 
left and right on the yellow value window.

Motion controls

Opacity controls

Motion pane selected                                                                                                      Picture-In-Picture with wireframe 

Source video
edited to Video 2

Click and drag to change value
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Video Effects

Many video effects can be found in the Effects Panel (often 
hidden as a tab behind the Browser). Drag an effect from 
the Effect Panel on to a clip – when that clip is selected in 
the Timeline, the effect controls appear in the Effect Con-
trol panel, under the Motion and Opacity controls.

Keyframe animation
Most effect parameters (and those in the Motion, Opacity and Audio panes) can be 
animated using keyframes. Click the small stopwatch icon to animate a parameter. 
After clicking the stopwatch, a keyframe is automatically added at the playhead 
position – it takes the current value of the parameter.

Moving the playhead to a different position and changing the parameter value automatically adds another key-
frame. Values (position, scale or an effect parameter like blur) interpolate from keyframe to keyframe creating a 
change over time.

Keyframes can be added manually – click the icon (see above right) to add a keyframe. Use the buttons on the in-
terface to move to the next or previous keyframe. A keyframe graph shows the state of the animation.

Controls for a Gaussian Blur effect

Click to animate                                                                          Keyframes

Click to animate Prev KF  Next  KF

Add/remove KF

Animating a PIP over time. The graph shows the speed of the moving frame
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Creating Titles
Premiere Pro has a built-in Title Tool. Titles can quickly be created in many 
styles; they can be superimposed over background video or can stand alone. 
Start by choosing New Title from the Title menu. This section deals with still 
titles.

Choose ‘Default Still’ and a dialogue box opens. The frame size is based on the 
settings for the current sequence – this is normally the right choice. If no sequence 
is loaded in the Timeline, the options will reflect the most recently edited sequence.   
Enter a name for the title and click ‘OK’.

The Title Panel opens. On the left is a tool palette for creating different sorts of text 
and graphic shapes. On the right are Transform and Property options to modify a 

title object. At the bottom of the window is a panel of preset styles – these make a good starting point as text objects 
can easily be altered. The background video frame is that under the playhead in the Timeline – it is a useful refer-
ence but does not form part of the title.

To make a simple title, choose the horizontal text tool, click in the frame and start typing. 
When done, choose the Selection tool and a bounding box appears around the text.

You can change the size of the text by dragging one of the handles on the 
bounding box (hold the Shift key to avoid distorting the text). Text size 
can also be adjusted in the property options above the frame (these op-
tions are duplicated in the Property pane on the right of the frame).

Simple graphic shapes can be made with one of the graphic tools in the tool palette. More complex shapes can be 
drawn with the Pen tool (and adjusted with the associated tools).

Rotate tool

Selection tool

Text tools

Path tools

Graphic tools

Font                         Style           Size  Kerning  Leading   Alignment
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If you create multiple shapes (a strap behind text perhaps), you can rearrange the order. Se-
lect an object and send it forward or backward from options in the Title menu.

In the illustration (right), the inner of the two safe areas is 
conventional TV Title Safe; keep all text inside this area if the programme is likely to be shown on a CRT television. 
For showing on a computer or a modern flat-screen TV, it’s OK to go out as far as the outer ‘Safe Action’ zone but 
beware – all displays are likely to cut off some of the picture.

Adjusting text and graphic shapes
All objects can have their fill colour changed, have drop shadows or borders (strokes) added and so on. All these 
controls are found in the Title Properties panel. Some of the options change depending on the type of object (text or 
graphic) which is selected.

To create a title on a coloured background, select the Background checkbox at the 
bottom of the panel.

Explore the options available – fills and strokes can be solids or gradients. Col-
ours can be chosen from a colour picker or sampled with an eyedropper.

Saving and editing titles
As soon as a title is named and started, it is placed as a 
clip in the Project Panel – there is no need to save it when 
finished, simply close down the Title Tool. Do not use the 
keyboard shortcut Command+W to close the Title Tool as it 
will simply close the individual panes – click the red close 
button at top left.

Each title as created is a nominal 5 seconds in duration. 
Simply drag it into place in the sequence and trim out as 
required (it can be extended beyond 5 seconds). Place the 
title on Video 2 or higher to have it superimposed over the 
background video on Video 1.

Modifying titles
To modify an existing title, double-click it in the Project Panel 
or Timeline and the Title Tool will open, allowing changes to 
be made.

This will modify all instances of the title.

To make a new title based on an existing title, click 
the small icon at top left of the Title Tool and save 
under a new name when prompted.

Text object
Graphic object

Title Safe area
Action Safe area

Transform

Fill (main colour)

Stroke (border)

Shadow

Background

Click to create new title based on existing
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Rendering and Playback
When editing, you may find that some parts of a sequence may not play correctly due to the video format or codec 
or the complexity of the video effects. Premiere Pro highlights such areas in the timeline with coloured bars.

To prepare to render, place the Work Area 
bar over the part of the sequence you plan 
to render. Move the bar by dragging on the 
centre and change the length by dragging 

the yellow handles at either end. To render the work area, press ‘Return’ on the key-
board. A window shows the progress of the render (see right).

Exporting a sequence
When the edit is complete, it’s time to export the sequence. Select the sequence 
in the Project panel and go to File>Export>Media.

The Export Setting window opens. There are many export presets but if noth-
ing matches what you need, it’s possible to modify an existing setting.

A useful format for YouTube upload is a 25 fps 720P QuickTime movie with 
the H264 codec with a bit rate of around 6-8 Mbps. As there is not an exact 
match to this setting in Premiere Pro we can modify one that is close as an 
example.

In the Format menu (top right), choose QuickTime and in the Preset menu, 
choose HD 720p 24, H264, AAC 48kHz.

Rendered (green)          Needs rendering (red)   Work Area
May need rendering (yellow)                       Does not need rendering (no colour)

Drag end to extend     Drag at centre to move

Preview
window

Select Preset

Output file name

Adjust video
settings here

Queue sends to Media Encoder                Export starts export immediately
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This setting needs to be changed to 25 fps. Open the Basic Video Set-
tings pane (at bottom right of the main settings window). Change the 
frame rate to 25.

Once this is done, you can save the changes as a new preset for future 
use (see below). Give the preset a meaningful name (indicating the 
format and frame rate, at least):

If you return to the same machine, you can reuse the preset.

Before you export the file, choose how much of the sequence to export. 
There is a menu below the preview monitor. Choices are ‘Entire Se-
quence’, ‘Sequence In/Out’, ‘Work Area’ and ‘Custom’. The first three are set in Premiere Pro; Custom is set using 
the In-Out markers below the preview monitor.

The final step before exporting is to choose a name and location for the exported file. Click on the yellow default 
output name at the top right of the Export Settings window. This will open a dialogue window where you can 
choose a file name and location.

When ready, click either ‘Queue’ or ‘Export’. 
‘Queue’ sends the file to Adobe Media Encoder 
where the export is done as a background task, ena-
bling you to carry on editing in Premiere Pro. 

‘Export’ starts the export 
immediately but prevents 
any work being done in 
Premiere Pro until the task 
is finished.

You can check the exported file by opening it in Apple Quicktime Player. Use 
the keyboard shortcut Command+I to open the QuickTime Player Inspector 
(right), where you can check that the export settings are correct.

Click to save custom preset

Save a custom preset

Basic Video Settings

Setting the export duration


